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Chapter 3:  Using SEER*DMS 
SEER*DMS uses an HTML-based interface displayed via a web browser.  Although the screens are 
displayed in a web browser, the system is not connected to the public internet.  Access to the 
system requires a secure connection using a site-to-site VPN between the registry’s network and 
the SEER*DMS server; or a client-to-site VPN configured on an individual workstation. 

In this chapter, you’ll learn about 

• System Requirements 
• Logging into SEER*DMS 
• Changing Your Password 
• Using the Home Page 
• Account Settings 
• SEER*DMS Menus 
• SEER*DMS Dos and Don’ts 
• Automatic Logoff Due to Inactivity 
• Using the SEER*DMS Test Server 
• News Displayed on the Home Page 
• Editing Tips: 

o Viewing More Information on Your Screen  
o Viewing Two Screens at Once  
o Searching for Text 
o Keyboard Shortcuts  

• Recommended Browser Settings 
• Using Filters in SEER*DMS 

o SEER*DMS Manager Pages 
o Filter and Actions Toolbar 
o Saved Searches 
o Saved Searches Tab 
o Default Saved Search 

• Changing Pages on Manager Pages 

System Requirements 
The following Web browsers are supported:  Mozilla Firefox, Google Chrome, and Microsoft Edge.  
Apple Safari may work but has not been widely used or tested. It is recommended that you update 
your browser on a regular basis. Adobe Reader may be required to view or print reports if it is not 
available within the browser.    

SEER*DMS processes are executed on a server accessed via a secure connection.  This may involve 
a site-to-site VPN which essentially extends the registry’s network to include the SEER*DMS 
server; or the connection may require installation of a VPN client on each user’s computer.    

No software, other than a web browser and possibly a VPN client, needs to be installed on the 
user’s computer.  SEER*DMS can be accessed by standard desktop or laptop computers.  These 
workstations must conform to registry requirements regarding data security.  Patient data, 
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including personally identifiable information (PII), may be written to the workstation in the browser 
history or downloaded reports. 

It is recommended that SEER*DMS users, particularly registrars and coders, use a computer that 
has at least one widescreen monitor.  The monitor should have a minimum resolution of 1080p, but 
an even greater resolution will increase the amount of data and text displayed without scrolling.  

• Recommended for registrars and coders: 2 monitors with minimum resolution of 1080p. 
• Minimum for registrars and coders:  2 monitors, at least one 1080p.  A second monitor is 

necessary to view coding manuals or to view multiple SEER*DMS pages at the same time. 
• Minimum to use SEER*DMS (not recommended for registrars and coders): single monitor 

with a minimum resolution of 1080p. 

Logging into SEER*DMS 
To access SEER*DMS, direct your web browser to the address provided by your registry’s IT staff.  
In most cases, a shortcut will be available on your desktop and SEER*DMS will be configured as 
the home page.  A manager or system administrator will create a SEER*DMS account for you and 
provide you with login information.  
 
The SEER*DMS Login page is shown below.  The Forget your password? link is displayed unless 
your registry uses the registry network’s username and password (this is rare).   

 

If your login attempt is unsuccessful: 

• Usernames and passwords are case sensitive.  Make certain Caps Lock is turned off. 
• Contact your supervisor to verify your username and to determine whether your account is 

inactive or locked. 
• Use the Forget your password? link to reset your password.  Contact your supervisor if you 

have forgotten your password and the link is not shown on the screen. 

Be sure to log off SEER*DMS when not using the system.  If you do not log off, confidential data 
may be displayed on your monitor or be accessible from your computer.  Save your current work, if 
necessary.  To log off, click the Logoff link which appears in the top right corner of each page.  
Your session will be ended, and the Login page displayed. 
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Changing Your Password 
Registry management can request to have SEER*DMS use the same usernames and passwords as 
the registry’s network (LDAP authentication).  This is currently only used in one registry. All other 
registries have a username and password defined specifically for SEER*DMS. When a password 
expires, you will be able to login to the system and will be prompted to change your password.  
Passwords expire after your first login and after the timeout period defined by registry 
management. The default setting is 180 days and is set in the system configuration 
(system.password.timeout.days).  

To change your SEER*DMS password: 

1. You will be prompted to change your password if it has expired.  You may change your 
password at any time by clicking your username in the User Bar.  On the Account 
Information page, click the Change Password button. This will not be shown if your 
registry uses LDAP authentication. 

2. Enter your Old Password. 

3. Enter a New Password.  SEER*DMS requires the use of strong passwords to protect 
confidential data.  Your password should not be a common word and should not include your 
name, your child’s name, or your pet’s name.  Your password must: 

a. Be 15 characters or longer (minimum length is defined by registry management and 
must be 8 or greater; 15 is recommended and is the default setting for new registries) 

b. Include at least 3 of these 4 character types: uppercase, lowercase, digit, symbols 

c. Not include your username 

d. Not include the same character 3 consecutive times 

e. Not be the same as any of your previous 24 passwords 

f. Not share a sequence of 6 characters or more with your previous password 

4. Re-enter your new password in the Verify Password field and click Save. 

Using the Home Page 
The SEER*DMS Home page is your gateway to the system’s tools and features. It is displayed each 
time you login to SEER*DMS.  At any time, you can return to the home page by clicking the 
SEER*DMS logo in the banner, selecting View > Home, or by using the Alt + H shortcut.  
 
Tasks 
The Tasks section on the left side of the home page shows the number of tasks by task type.  You 
can view counts on four tabs:  My Tasks shows tasks assigned to your account, there is a tab for 
Unassigned tasks, All tasks, and lists of tasks defined by Saved searches.  The task types are 
links. For example, click Consolidate on the My Tasks tab to go to the worklist.  The worklist filters 
will be auto-set to show the Consolidate tasks assigned to your account.   

The Tasks link above the tabs can be used to view all tasks for that tab in the worklist. For 
example, click Tasks while viewing the My Tasks tab to view all tasks assigned to your account 
regardless of task type. 

The Tasks section on the right shows the number of tasks by data type and year of diagnosis.  The 
Prior tab shows tasks for years prior to the current reporting year.  The Unk tab shows tasks for 
data with an unknown reporting year (9999).    
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Recently Viewed 
Your most recently viewed records and Patient Sets are listed on the bottom left of the home page.  
To remove all items from the list, click Clear.  To view the full list in the Data Search, click the 
Recently Viewed heading.   
 
The number of items and the style are controlled by user settings.  You can control whether patient 
names are displayed, hidden completely, or masked.  To change the number of items or the format 
of the list, click your username in the user bar, go to the System section of settings, and set 
values for Recently Viewed Format and Recently Viewed Number.  
 
Dashboard Summary 
A dashboard summary is displayed on the home page if you have dashboard system permissions.  
A summary of SEER completeness is displayed if you have the DQP dashboard permission.  
Summarized counts of failing edits are shown if you have the Edits dashboard permission.  Click 
the Dashboard heading to view the full Dashboard. 
 
Other features of the SEER*DMS home page: 

• The Latest News section displays News items posted by registry staff. 
• The SEER*DMS Logo, User Bar, and Toolbar appear at the top of every SEER*DMS page.   

o Click SEER*DMS to return to the home page from any page in the system.   
o The User Bar includes access to account settings and the Logoff link.  If you have a 

system permission to view or edit patient data, it will also include the “Lookup” 
search box (Chapter 20:  Searching for Records and Patients has information about 
the toolbar quick search and other searching techniques.) 

o The name of the current page is displayed on the left side of the Toolbar.  
o The Toolbar also includes menus that provide access to all pages and features in the 

system (see the SEER*DMS Menus section of this chapter). 
o To avoid the loss of effort when using these features, follow the guidelines specified 

in the SEER*DMS Dos and Don’ts section of this chapter. 
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• Click the version number (22.46 in the screen shot below) to view system information. 
  

 

o Title – The full registry title. 
o Time Zone – Default time zone for the registry.  Some users may be in different 

time zones, but the default time zone is used in all timestamps written by the system 
(audit logs, server logs, etc). 

o Registry – Registry abbreviation that is used throughout SEER*DMS. 
o ID – Registry ID (NAACCR Item #40). If the system supports multiple registries then 

the default registry is listed. The SEER Registry ID is used for SEER registries. 
o NAACCR – The SEER*DMS database is updated to the latest version of NAACCR 

each year. This screen shot indicates that the NAACCR 22 fields were added to the 
database and all necessary N22 conversions were applied to the database.  It is the 
latest version of NAACCR supported in imports (earlier versions can also be 
imported). 

o NHAPPIA – This shows the version of the NHAPPIA algorithms (17 in this screen 
shot) and the NHIA algorithm option (0 in this screen shot).  Please see the NHIA 
section of the Polisher help page for a description of the options. 

o CStage – The version of the Collaborative Stage DLL currently used by SEER*DMS. 
o TNM – The version of the TNM API currently used by SEER*DMS for diagnosis years 

2016-2017. 
o EOD – The version of the EOD API currently used by SEER*DMS for diagnosis years 

2018 and later. 
o Heme – The date and time that the list of hematopoietic diseases for multiple 

primary evaluation was updated.  
o SEER Edits – The current version of SEER edits deployed in SEER*DMS. 
o NCDB – The name of the CDC metafile used for the NCDB edits provided within 

SEER*DMS.   NCDB, NAACCR, and NCFD edits are obtained by translating the 
GenEDITS metafiles provided by the CDC.  
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o NAACCR – The CDC metafile used for the NAACCR edit set. 
o NCFD – The CDC metafile used for the NAACCR Call for Data (NCFD) edit set. 
o NPCR – The CDC metafile used for the NPCR Call for Data edit set.   
o SEER*DMS – The current version of the SEER*DMS application.   
o Revision –  Build information of the compiled source code.  IMS staff may use this 

information when investigating technical support issues. 
o Build Date – A timestamp indicating when the source code was compiled at IMS. 

The Deployed date shows when this build was deployed in your registry. 
o Branch – The development version of the source code.  Branching is a standard 

technique for managing software revisions.  
o Initial Release – The date that SEER*DMS first went into production in the registry. 
o Current Release – The date that the current version was deployed. 
o Last Restart – The last time that the application was restarted.  Typically, this 

coincides with the date deployed.  However, there are times that the system is 
restarted without an update to the application. 

o Next Update – The date and time of the next scheduled system update. 
 

Account Settings 
Your contact information and settings are associated with your user account.  To modify your 
account, click your username in the SEER*DMS user bar.   The main sections appear in the left 
navigation.  Use the search to quickly find a specific setting.   

Account Information: 

• Username and email.  These fields are read-only on this page.  Usernames and email 
addresses associated with SEER*DMS can be changed. To request a change to your 
username or email, please contact your registry manager. 

• Password.  If your registry is using passwords maintained in SEER*DMS then you can use 
the Change Password link to update your password.  If your registry is using a registry 
system to verify user accounts, then you must update your password through your 
registry’s system.  

• API Key. An application programming interface (API) key is a code used to authenticate a 
user when one program calls another.  For example, an API key is used when a SEER*Abs 
user connects to SEER*DMS. If you generate a new API key then it will be displayed once so 
that you can copy and set it in the other application. 

• Contact Information.  First and last name are the only fields required in this section.  Use 
of other fields in this section is determined by the registry management.   

Colors: 

• Theme – This determines the palette used for the SEER*DMS user interface.  You may 
choose white for high contrast, or light gray to reduce brightness. 

• Keyword Match Style - SEER*DMS uses color-coded highlighting to emphasize significant 
words or phrases in text fields. If you select Keyword, the text will be shown in color and 
the background will be the same as other text. If you select Background, a colored box will 
highlight the word. If you select None, the keyword highlighting will be turned off. 
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Editor: 

• Consolidated Record List – This setting controls the look of the record navigation in the 
left panel when you first open the Patient Set.  Set to Expanded if you would like all linked 
records listed and all facility sections expanded. Set to Compressed if you want to hide the 
record IDs and only want to see the number of records per facility. 

• Default Tab in Info Popup –This determines which tab is shown first in popups. The 
choices are the popup’s first tab; or the system can remember the tab you were viewing the 
last time.  This affects the popup shown when you click a field label in the editor, as well as 
information popups for Records, Patient Sets, Facilities, Contacts, etc.  Information popups 
are shown when you click the information icon next to an ID. 

• Field Auto Tab - If set to Always, your cursor will automatically move to the next field 
when you enter a complete value in a field.  If set to Date Only, this will only apply to date 
fields (the cursor will move from day to month to year).  If set to “Date Only (Include 
Year)”, the cursor will also move to the next field when the year is filled. If set to never, 
then the cursor will never automatically move to the next field. 

• Summary header view format – This controls the format of the header in the Record and 
Patient Set Editor. You may show the header in normal text, hide the header, or blur the 
header. If blurred, the header can be seen by mousing over the text. 

• Treatment View – If set to Comparison Mode then TX data will be shown in columns. If 
viewing all TX data for a Course, the Summary TX and each TX in that course will be 
displayed. You may also limit the view to TX pages from a specific facility (and in the same 
course). If Page Mode is selected, then you will view the data for a single TX or Summary 
TX on one page. 

Editor (Text Panel): 

• Date order for Text Fields – This affects the order of text fields in the right panel of the 
record and patient set editor. When the text fields are sorted by event date, you may 
choose to show the earliest date first (ASC) or show the latest date first (DESC). 

• Default for Display Text From – Use this to specify the value of the text menu when you 
first open a Patient Set.  The menu can be set to Record fields, CTC fields, or Record and 
CTC fields.  Use Record and CTC fields to view all available text. 

• Default for Group Text By – Use this to specify the default order and grouping of fields in 
the text panel.  The options are By Field, By Facility, or By Record.  Set it to By Field to 
show one header per data item.  The text from all records will be shown under the field 
header; duplicate text values will not be shown.   

• Hide non-values – If set to yes, the Hide non-values box on the Text Panel will be checked 
when you open a Patient Set.  The Hide non-values feature reduces text by excluding text 
fields that only have terms like unknown, not available, none, etc. 

• Lock – If set to yes, the Lock box on the Text Panel will be checked when you open a 
Patient Set.  If the text panel is locked then it does not change when you move from page 
to page.  If not locked then the text panel changes to text fields related to the new page. 
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Editor (Rx-Tx Tab): 

• Date Range Default – This determines the value of the Date Range control on the RxTx 
tab when you first open a Patient Set.  Date Range is an option to limit what is shown based 
on the date of the pharmacy fill, claims date, and other RxTx event dates.   Set the default 
to All Events if you want to see all events in the Patient Set even when you go to a CTC 
page.   Set this to Based on the Current Page if you want to limit the display to events 
based on a CTC's year of diagnosis; the data in the RxTx tab will update as you move from 
one CTC to another. 

• Default View Type – This determines the value of the View Type option when you first 
open a Patient Set.  Typically, this would be used to limit the display to events pending 
reviews but can be set to all events. 

Note: (The Rx-Tx settings can also be accessed using the gear icon in the Rx-Tx tab) 

Email Settings: 

• Task Assigned to You – You can control how often you receive email when another user 
assigns tasks to your account.  The options are always, or you can reduce email so that you 
only receive a message if the other user adds a note as they assign tasks. Emails are not 
sent when the system auto-assigns tasks. You can set this option to Always or reduce email 
by setting it to email when the user adds a note when they assign tasks. 

• You Assign a Task – Set to Yes if you wish to receive a copy of the email sent when you 
assign tasks to another user. 

Filters: 

• Hide Inactive Contacts - This controls the default filter settings when searching for a 
contact. If set to yes, Inactive Contacts will be hidden when you first open the Contact 
Manager and Physician Lookups. 

• Hide Inactive Facilities - This controls the default filter setting when searching for a 
facility. If set to yes, Inactive Facilities will be hidden when you first open the Facility 
Manager and Facility Lookups. 

System: 

• Audit Log Order - This determines the order that events are listed in all Audit Logs 
(Patient Set, Record, Contacts, Facilities, AFL, etc). 

• Enable SQL Autopairing - If set to Yes, the Data Search SQL editor will automatically pair 
quotation marks and parentheses. The closing quote or paren will be added after you type 
the opening quote or paren. 

• Patient Lookup Exclusion – This is the default value for an option to exclude data when 
search for a specific patient using the Patient Lookup. The Patient Lookup has an option to 
exclude data for patients based on vital status.  If blank, then no data are excluded.  The 
other options are to exclude data for patients who died more than 4 years ago; or more 
than 8 years ago.   

• PDF Viewer - This affects the display of PDFs in the SEER*DMS interface (eg, images in the 
Patient Set Editor). You can use the SEER*DMS PDF viewer (pdf.js) or your browser's 
default PDF viewer. For example, Chrome may use a different viewer by default. Try your 
browser's viewer if PDFs are not displayed correctly in SEER*DMS. 
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• Recently Viewed Format – This determines the style used for the items shown in the 
Recently Viewed list on the home page.  The data type is always shown (Patient Set or the 
record’s type). Next to the data type you can choose to show the patient’s name or ID.  If 
you choose to include the patient’s name then you may show it in normal text or blurred.  If 
blurred, then the name is visible on mouse over. 

• Review Viewed Number - This controls the number of records and Patient Sets listed in 
the Recently Viewed section of the homepage.  You can show a maximum of 50 entries on 
the home page.  Click the Recently Viewed header to see additional data items for recently 
viewed data (200 entries will be displayed in the data search). 

 

SEER*DMS Menus 
A Toolbar is displayed on every page in SEER*DMS. 

 

The name of the current page is displayed on the left of the toolbar.  On the right, the toolbar 
displays pull-down menus to access various features of the SEER*DMS system.  A full menu or 
menu item will be hidden if you do not have the relevant system permission. 

• View 
o Home 
o Worklist (Chapter 4: SEER*DMS Workflow) 
o Data Search (Chapter 20:  Searching for Record and Patients) 
o Patient Lookup (Chapter 20:  Searching for Record and Patients) 
o Contacts (Chapter 19: The Contact List) 
o Facilities (Chapter 18: The Facility List) 
o Dashboard (Chapter 29:  Registry Management and SEER*DMS) 
o Reports (Chapter 24: Creating Reports and Extracting Data) 

• Manage 
o Abstract Facility Leads (Chapter 21: Managing Abstracting Assignments) 
o Active Follow-up (Chapter 16:  Follow-up) 
o Death Clearance (Chapter 17:  Death Clearance) 
o Follow-back (Chapter 22: Follow-back) 
o Special Studies (Chapter 28: Special Studies) 

• Tools 
o Hematopoietic and Lymphoid Database (Chapter 11: The Patient Set Editor) 
o SEER*Rx (Chapter 11: The Patient Set Editor) 
o SEER*RSA 
o SEER Summary Staging 
o SEER Program Coding Manual 

• System 
o Roles (Chapter 26: System Roles and Permissions) 
o User Accounts (Chapter 25: Managing User Accounts) 
o Edit Manager (Chapter 7: Edit Errors) 
o Imports & Data Entry (Chapter 5: Importing Data Files and Chapter 6: Data Entry) 
o Keywords (Chapter 9: Screening for Reportability and Chapter 27:  System 

Management) 
o Reference Data (Chapter 15:  Reference Data) 
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o Workflow (Chapter 4:  SEER*DMS Workflow) 
 Worklist Flags (Chapter 4:  SEER*DMS Workflow) 
 Task Manager (Chapter 4:  SEER*DMS Workflow) 

o Tasks (Chapter 27: System Management) 
o Test Server (Chapter 27: System Management) 
o Configuration (Chapter 27: System Management) 
o File Transfer (Chapter 27: System Management) 
o Administration (Chapter 27: System Management) 

• Help 
o User Manual 
o Shortcuts 
o Registry-defined configuration settings and algorithms (AFL, Auto-build, etc) 
o Version History 
o Tech Support (Technical Support section of Chapter 27: System Management) 
o SEER*DMS Portal 
o About SEER*DMS 

SEER*DMS Dos and Don’ts 
You will modify data and access features on system “pages”.  If you are on a page that allows you 
to modify data, you should always use the buttons within that page to exit.  These buttons include 
“Save & Exit”, “OK”, “Close”, and “Cancel”.  If you click User Bar links, Toolbar menus, or use 
keyboard shortcuts to leave an editor, changes will not be saved.  Likewise, if you exit an editor by 
using your browser’s navigation controls, unsaved changes will not be saved.   

Do 

• Use the links, buttons, and menus located in the body of the page to complete the current 
task.  If you have made changes that must be saved, do not use the navigation in the 
SEER*DMS logo, User Bar, or Toolbar to exit a page.  

• Click the SEER logo to return to the home page, but only if you saved any changes made on 
the current page or do not wish to save them. 

• Click the links to go the Patient Lookup or your Account; or use the View or Manage menus 
to access system features.  But only use these if you have already saved changes made on 
the current page or do not wish to save them.    

• Use the Tools menu.  All tools open in separate windows to enable you to use these tools 
while editing data. 

• Use the Help menu to open the SEER*DMS Users Manual.  It also opens in a separate 
window and may be viewed while editing data. 

Don’t 

• Don’t use any browser controls to navigate.  Never use the Back button, Forward button, or 
enter a URL in the address box.  The Browser Navigation Settings section of this chapter 
provides more information about the browser controls to avoid; and methods for hiding 
navigation features that you should not use.   

• Don’t use the backspace key unless you are editing a field.  In a browser application, 
backspace is a shortcut for the browser’s Back button. 
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Automatic Logoff Due to Inactivity 
It is strongly recommended that you click Logoff to end your session when not using the system.  
If you do not logoff, SEER*DMS will automatically end your session after a long period of inactivity. 

The system is initially configured to end your session after two hours of inactivity; however, the 
length of time is controlled by a configuration parameter that can be changed per request of 
registry management (system.session.timeout.seconds).   A warning will be displayed two minutes 
before your session will end.  You will have the opportunity to continue the session, if you wish.  
(Note:  the system.session.timeout.warning.seconds configuration parameter actually controls the 
length of time between the warning and the logout.  It is typically set to two minutes.) 

Note: Moving the mouse and entering text do not constitute activity between the browser and the 
SEER*DMS server.  Until you click a button, link, or a field lookup to perform an action or access 
another page, your session will be considered inactive. 

Using the SEER*DMS Test Server 
Two versions of SEER*DMS are available at each registry.  The production or “live” version of 
SEER*DMS accesses the registry’s true database.  A second application and database are available 
for testing and training; access to the test server is limited to users with the test server 
permission.  The test server data are reloaded by registry IT staff.    

News Displayed on the Home Page 
System permissions:   news_edit, news_manager 

The Latest News displays news items in the order in which they were added or modified, with the 
most recently modified news appearing at the top of the page.  News items can be restricted to 
certain roles or shown to all SEER*DMS users.  System permissions are required to add news 
items. A user with the news_edit permission can create a news item that is displayed to other 
users with the same roles; news_edit also allows the user to edit or delete a news item that they 
created.  A user with the news_manager permission can create a news item for a specific role or 
for all users.  A news manager can edit and delete any news item.  

To add or edit a News Item: 

1. Click the add item link at the top of Latest News; or click the edit link for a news item. 

2. Enter a Title for your news item.  This field can hold a maximum of 100 characters. 

3. Select the appropriate roles in the Roles field. 

4. Enter text in the Body field.  You may enter up to 4000 characters.  Use the formatting 
controls to embed links, specify font, font size, color, highlighting, create bulleted lists, etc. 

5. Click Save.  Your message will appear at the top of the news list. 

To delete a News Item, click the Delete link on the news item’s title bar. 

News items can be restricted by role, but news managers have the option to see all news items.  A 
link is shown above the news section if you have the news_manager permission.  Click Show All 
News to see all news, regardless of role.  Click Show My News to see news restricted to your roles.   

Restricting news by role is typically used to hide news from non-registry users who have limited 
access roles in SEER*DMS. 
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Viewing More Information on Your Screen 
The data pages in SEER*DMS may contain too many data items to display on your monitor without 
scrolling.  If you would like to view more information on your screen at one time, you may want to 
consider the following: 

• Chrome and Firefox have a “Full Screen” feature that enables you to hide toolbars and 
controls that use valuable screen real estate.  Press F11 to view SEER*DMS in full screen.  
Your Windows taskbar and browser menu will be hidden, and a larger number of data fields 
will be displayed.  Press F11 again to restore the Windows taskbar and browser menu.  

• Increasing your monitor resolution will reduce the need to scroll while editing.  Consult your 
registry IT staff for instructions for setting the optimal resolution for your monitor. 

Viewing Two Screens at Once 
You may view more than one SEER*DMS page at a time.  The second page can be opened in a new 
Window or Tab.  In Chrome, new pages are opened in a new tab by default.  Firefox has a 
preference that controls whether a new page is opened in a window or tab.  If you are using a 
single monitor, it is recommended that you open new pages in tabs within a single Window 
(multiple Windows may be hidden on a single monitor).  If you are using two monitors, you may 
want to open a new Window and move the second Window to the other monitor.   

To open a second SEER*DMS page: 

1. Right-click a menu item or link in SEER*DMS.  A menu will be displayed.  Select “Open Link 
in New Window” or “Open Link in New Tab”. 

2. Or “Middle-click” a link or menu item in SEER*DMS.   To “Middle-click”, you may either click 
your mouse wheel or press CTRL as you click.   The page will open as a new tab or new 
Window depending on the settings in your Firefox options. 

In the record and Patient Set editors, the current page will be opened in the new window or tab.  
You can then navigate to the new page. 

Searching for Text 
CTRL+F can be used to search within a window in Chrome or Firefox.  This is a great tool to use 
when searching for a field in the Patient Set Editor or when searching for text in a popup window.   

1. Press CTRL+F 

2. Enter search text.  The text box is at the top of the screen in Chrome; it is at the bottom of 
the screen in Firefox.  The first occurrence of the text will be highlighted. 

3. Click the Down Arrow to go to the next occurrence of the search string.  In Firefox, you can 
also click Highlight All to see all matches. 

 



Using SEER*DMS    3/28/2022 3-13 
 

Keyboard Shortcuts 
SEER*DMS supports keyboard shortcuts for many of the menu items and for specific actions.  
There is a set of shortcuts that works on all pages (shown to the left).  Additional shortcuts are 
available in the Patient Set Editor, Record Editor, and the Pathology Screening task (as shown in 
the diagrams below) 
 
At any time, you may press F1 to view the list of keyboard shortcuts that are available for the 
current page.  The shortcuts for menu items are listed in the menus.   
 
 
 

All SEER*DMS Pages Patient Set Editor 

 

 
Pathology Screening Matching 
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Recommended Browser Settings 
Firefox, Chrome, and other browsers “remember” passwords and information entered into a form in 
order to provide suggestions when completing similar forms in the future.   

• For increased security of the confidential patient data in SEER*DMS, you should disable the 
option to save passwords.  Do not save your password in your browser settings. 

• SEER*DMS disables form filling to avoid entering one patient’s data into another patient’s 
form.  If other pages in SEER*DMS are auto-filled, then please report the issue to 
SEER*DMS technical support; you may also disable your browser option to remember 
information previously saved in forms.   

Pop-up windows are used for a variety of reasons in SEER*DMS.  To ensure that all features work 
correctly, configure your browser to allow pop-ups created by SEER*DMS.   

To give additional space to SEER*DMS, consider hiding your browser’s menus and toolbars.   

SEER*DMS Manager Pages 
SEER*DMS has several “manager pages”.  These are screens that allow you to view, sort, and 
process lists of items.  For example, the Worklist is a manager for tasks.  Other managers in 
SEER*DMS include the Contact List, Facility List, AFL Manager, Death Clearance Manager, and 
Active Follow-up Manager.   

Each manager has three components (see numbers on screenshot below):  1) the Filter and 
Actions Toolbar on the left has a filter for each of the key data fields, an Actions menu, and 
other controls; 2) the Results Tab in the body of the page shows the filtered list of data items; 
and 3) the Saved Searches Tab in the body of the page shows the complete list of saved 
searches in a list that can be sorted and searched.    
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The data shown on the Results tab are sorted by the column with a bolded column header. This 
example shows the Results tab for the worklist. It is sorted by Task ID.  The up arrow next to 
“Task” indicates that the table is sorted in ascending order.   

Click a column header to sort the table by that data item.  To reverse the sort order, click the 
column header again.  If you create a saved search, the sort order will also be saved. 
 
The check boxes in the first column allow you to select individual items in the list.   If items are 
checked, actions are applied to the checked items.  If no items are checked, actions are applied to 
all items in the filtered list.   None of the tasks are checked in the example above.  Therefore, the 
Modify or Export action would be applied to all 236 consolidation tasks in the filtered list. 
 
To hide the toolbar and give more screen real estate to the Results Tab, click the double arrow next 
to the Results Tab.   You can toggle the view when you need to use the toolbar. 

Filter and Actions Toolbar   
The worklist toolbar is shown here as an example, but the following 
features are available in the toolbar of all manager pages. 
 
• Actions – Click the word Actions or the menu icon. Use this menu 

to modify items in the list, to export data, to save filter settings in 
a saved search, or delete saved searches.  The Actions menu will 
also include options that are specific to each manager page.   

• Drop-down list of saved searches – My Tasks is shown in the 
drop-down in this screen shot. If there are other saved searches 
then they will be available in this drop down (they are also 
available on the Saved Searches tab. If you select a saved search 
then the filters will automatically be set and the table reloaded. 

• Apply – Refreshes the Results using the current filter settings. 
• Reset – Returns the filter settings to default values. You can define 

a default for your account (see the Default Search section later in 
this chapter); or the page will default to its system default.  For 
example, the system default for the worklist is “User = myself”; 
and the system default for the AFL Manager is “Status = Open”. 

• Search Box – Enter text into the Search Box to quickly set a filter.  
SEER*DMS will auto-detect the type of text that you have entered, 
set the appropriate filters, and return results.   

• Filters – In this screen shot, the filters are Task ID, Task Type, 
User, etc.  These are search tools for individual fields.  Set a filter 
to limit the results to certain values for a field. Instructions for 
using the different types of filters are provided in the Filter Tutorial 
that is available on the SEER*DMS training website:  
seer.cancer.gov\seerdms\manual. 

 

  



Using SEER*DMS    3/28/2022 3-5 
 

Saved Searches 
Once you set the filters, you may save the filter settings as a Saved Search.   The value of each 
filter and the sort order will be saved.    

To save your filter settings as a saved search: 

1. Select Actions -> Save Search.  The fields with an asterisk (*) are required. 

  

2. Overwrite option – Set the value in this drop-down to Overwrite if you are updating a 
saved search.  Set this to Create New to save a new search. 

3. Enter a Name for the search.  If you are overwriting a saved search, then there will be an 
option to rename search.  

4. If you have the permission to manage saved searches, then you have the option of making 
searches available to other users.    

a. To create a saved search for your own user, set the controls so that Available To = 
Specific User and User = myself. 

b. To create a saved search for one other user, set the controls so that Available To = 
Specific User and User = their username. 

c. To create a saved search available to all users, select All Users in the Available to 
list. 

d. To create a saved search for a group of users, set the controls so that Available To = 
Specific Role and select a role.   

5. Enter a Description of the search.  Any user who has access to the saved search will be 
able to view the description on the Saved Searches Tab. 
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Saved Searches Tab 
Use the Saved Searches tab to view all saved searches. This tab shows information about each 
search including the user who created it, the date last modified and the user who modified it, and a 
description (if one was entered when it was saved).  The Available To column shows who can see 
the search by default.  Setting the Available To attribute in a search is a way to make searches 
available to all users; or alternatively, reduce clutter in the user’s list of searches by make a search 
available to yourself or a small group of users.    

Users with the filter manager system permission have access to all saved searches, including 
searches that another user set as “my search”.  Filter managers are given access to other user’s 
private saved searches to provide technical support. 

 

 

 

The drop-down list on the left has the following choices: 

• My Searches – Use this option to view saved searches that are available for your use.  This 
includes searches available to your user account, searches available to all users, and 
searches available to your system roles.  

• User Searches – saved searches that are available to individual users. 

• Public Searches – saved searches that are displayed for all users. 

• Role Searches – saved searches that are available to specific roles. 

• All Searches – all searches, regardless of their availability. 

Default Saved Search 
You can create a search and save it as the default on any Manager Page (Worklist, AFL Manager, 
Death Clearance Manager, etc). Set the criteria using the filters and save the search. You may then 
select Actions > Set as Default Saved Search. Those search settings will be used by default when 
you go to that manager page and when you click Reset on that page.  
Note: If you click a shortcut to the worklist, that shortcut will be used and not your default. Click 
Reset to use your default. 
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Changing Pages on Manager Pages 
Lists shown in SEER*DMS managers, such as the Worklist, are often shown on several pages.  Use 
the Page Selection links displayed at the top of the list to navigate through the pages. 

  

Click Next to advance to the next page of results.  Click Jump to go to the X item in the list.  For 
example, if there are 1000 items shown in the worklist, you could enter 500 to advance to the 
page containing Item number 500.  

 

Click First to move to the beginning of the list or Prev to view the set of results immediately 
before those currently shown. 


	Chapter 3:  Using SEER*DMS
	System Requirements
	Logging into SEER*DMS
	Changing Your Password
	Using the Home Page
	Account Settings
	SEER*DMS Menus
	SEER*DMS Dos and Don’ts
	Automatic Logoff Due to Inactivity
	Using the SEER*DMS Test Server
	News Displayed on the Home Page
	Viewing More Information on Your Screen
	Viewing Two Screens at Once
	Searching for Text
	Keyboard Shortcuts
	Recommended Browser Settings
	SEER*DMS Manager Pages
	Filter and Actions Toolbar
	Saved Searches
	Saved Searches Tab
	Default Saved Search
	You can create a search and save it as the default on any Manager Page (Worklist, AFL Manager, Death Clearance Manager, etc). Set the criteria using the filters and save the search. You may then select Actions > Set as Default Saved Search. Those sea...
	Note: If you click a shortcut to the worklist, that shortcut will be used and not your default. Click Reset to use your default.
	Changing Pages on Manager Pages




